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Comments on the

Program Development Link
Documentation
 

We welcome your evaluation of this documentation. Your comments
and suggestions help us improve our products.

Program Development Link Documentation

Please circle a response for each of the statements below. You can use

the Comments space to provide additional opinions.

1=Strongly Agree 3=Neutral 4 =Disagree
2=Agree 5=Strongly Disagree

Printed On-Line
m | am satisfied with Getting Started. 12345
= | am satisfied with the on-line Help. 12345
= The information is well organized. 12345 12345
= | can find the information | want. 12345 12345
= The information is accurate. 12345 12345
= | can easily understand the instructions. 12345 12345

= There are enough examples. 12345 12345

= The examples are appropriate and helpful. 12345 12345

= The illustrations are clear and helpful. 12345 12345
= The amount of printed information is: too much appropriate too little

s The amount of on-line information is: too much appropriate too little

= The parts | refer to most frequently are:

Printed: Getting Started
On-Line: Environment Information Menu Descriptions Customizing

HP 48 Command Dictionary Other HP 48 Reference Information

Comments:
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Address:

City/State/Zip:
Occupation:
Phone: ( )
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Software License Agreement

Important: Please carefully read this License Agreement before

opening the media package or operating the equipment. Rights in the

software are offered only on the condition that the Customer agrees to

all terms and conditions of the License Agreement. Opening the media
package or operating the equipment indicates your acceptance of these

terms and conditions. If you do not agree to the License Agreement,

you may return the unopened package for a full refund.

In return for payment of the applicable fee, HP grants the Customer a

license in the software, until terminated, subject to the following:
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Use:

Customer may use the software on any one computer.

Customer may not reverse assemble or decompile the software.

Copies and Adaptations:

m Customer may make copies or adaptations of the software:

o For archival purposes, or

o When copying or adaptation is an essential step in the use of the

software with a computer so long as the copies and adaptations

are used in no other manner.

m Customer has no other rights to copy unless they acquire an

appropriate license to reproduce which is available from HP for

some software.

m Customer agrees that no warranty, free installation, or free training

is provided by HP for any copies or adaptations made by Customer.

m All copies and adaptations of the software must bear the copyright

notice(s) contained in or on the original.

Ownership:

m Customer agrees that they do not have any title or ownership of the

software, other than ownership of the physical media.

m Customer acknowledges and agrees that the software is copyrighted

and protected under the copyright laws.

m Customer acknowledges and agrees that the software may have been

developed by a third party software supplier named in the copyright

notice(s) included with the software, who shall be authorized to hold
the Customer responsible for any copyright infringement or violation

of this License Agreement.

Transfer of Rights in Software:

4

Customer may transfer rights in the software to a third party only

as part of the transfer of all their rights and only if Customer

obtains the prior agreement of the third party to be bound by the

terms of this License Agreement.

Upon such a transfer, Customer agrees that their rights in the

software are terminated and that they will either destroy their

copies and adaptations or deliver them to the third party.

Transfer to a U.S. government department or agency or to a prime

or lower tier contractor in connection with a U.S. government

contract shall be made only upon their prior written agreement to

terms required by HP.
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Sublicensing and Distribution: Customer may not sublicense the
software or distribute copies or adaptations of the software to the

public in physical media or by telecommunication without the prior

written consent of HP.

Termination: HP may terminate this software license for failure to

comply with any of these terms provided HP has requested Customer

to cure the failure and Customer has failed to do so within thirty (30)
days of such notice.

Updates and Upgrades: Customer agrees that the software does not

include updates and upgrades which may be available from HP under

a separate support agreement.

Export Clause: Customer agrees not to export or re-export the

software or any copy or adaptation in violation of the U.S. Export

Administration regulations or other applicable regulations.

 

Setting Up Your System

This section shows you how to set up the computer and HP 48 so you

can use the Program Development Link.

To write applications with the Program Development Link, you’ll need

an IBM PC or compatible computer containing:

m A 5.25-inch (360 KB or 1.2 MB) flexible disk drive, or
a 3.5-inch (720 KB or 1.44 MB) flexible disk drive.

m A hard disk drive.
s MS-DOS® operating system, version 3.00 or later.

m A Microsoft-compatible mouse (optional).

You’ll need these additional items to connect an HP 48 to the

computer:

m Serial port on the computer.

m HP 48 serial cable and adapter (included with the Program

Development Link).
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Installing the Software

Follow these steps to install the Program Development Link software

onto your hard disk. If you have problems, see “Fixing Problems” at

the end of this chapter.

1. Make sure the computer is turned on, and the MS-DOS operating

system 1s active.

Find Disk 1 for the Program Development Link and insert it into

flexible disk drive A (usually the upper drive). Choose the disk size

that fits your drive.

. Type

rn=tall

This makes drive A the active drive and starts the installation

process. Follow the instructions on the screen. The predefined

answers are usually the ones you want.

e
[

. When the installation is finished, remove the last disk from drive A.

. Hold and and press to restart the computer (or turn
it off and on). This activates the changes that were made.

Connecting the HP 48 and Computer

Follow these steps to connect your HP 48 to your computer’s serial

port:

1. Find the serial port on your computer—it’s either a 9-pin or 25-pin

connector. If your computer has more than one serial port, it’s

simplest to use the primary one, called COM1—or you can use

COM2.

. If you’re using a 25-pin serial port, attach the 25-pin adapter to

the HP 48 serial cable. (If you’re using a 9-pin port, don’t use the

adapter.)

Plug the cable into the computer’s serial port.

. Plug the cable into the HP 48 serial port—the 4-pin connector at

the top of the case.
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The HP 48 doesn’t need to be connected unless you’re transferring

data. You can unplug it whenever you want. Leave the cable attached

to the computer for convenient hookup.

 

What the Program Development Link Does

The Program Development Link enables you to develop applications

for the HP 48 using your computer. An HP 48 application is a

collection of one or more HP 48 objects that work together to perform

a task. The simplest application is a program—one program object.

A more complicated application might include subprograms,list

objects that contain custom menus or other data, or other types of

HP 48 objects. When you start using your system, you can look at the

LOOKUP.APP sample application that’s installed on your computer.

The Program Development Link gives you an on-screen work

environment for developing applications, complete with a specialized

editor. As you develop an application, you can send part or all of it to

the HP 48. There each object in the application is stored in an HP 48

variable. You can then run the application on the HP 48—or you can

operate the HP 48 from your computer.

The following sections help you try out some Program Development

Link features. For more information, start the system as described

next, then read the on-line Help information about the Program
Development Link. (See “To Get On-Line Information” later in this
manual.)
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Using the System

This section helps you get started using your system.

To Use the Keyboard or the Mouse

Before you start the Program Development Link, you’ll want to

understand how to do tasks. Instead of typing commands, you use

menus to specify the tasks you want to do. Each menu contains a

group of commands. If a command needs input from you, it displays a

dialog bozx for your input. Follow the simplified directions below.

Using the keyboard:

1. To get a menu, press (Alt), then use (€) and (®) to highlight the
menu you want, and press (e=#). (To get out of the menu bar,
press (Esc).)

. To pick a command in a menu, use (A) and (¥) to highlight the
command you want, and press (e=#). (To get out of a menu, press

&)
. To enter information in a dialog box, press or to
move from one field to another. Type the information needed.

For some tasks, you can choose options from a list—just move to

the list and use (A) and (¥) to highlight the item you want. After
you’ve entered all the information, press to do the task. (To
not do the task, press instead.)

Using a mouse:

1. To get a menu, click the mouse on the menu label—that is, move

the mouse until the pointer 1s on the label, then press and release

the left mouse button.

. To pick a command in a menu, click the mouse on the command

you want. (To get out of a menu, click the mouse outside the

menu.)

. To enter information in a dialog box, click the mouse on the field

and type the information needed. For some tasks, you can choose

options from a list—just click on the item you want. After you’ve

entered all the information, click the mouse on “OK.” (To not do
the task, click the mouse on “Cancel” instead.)
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To Try Out the System

You can try this sample session on your system. It gives you a chance

to see how you can create HP 48 applications on your computer.

The GEOM application in this example finds the volume and surface

area of a sphere for a specified radius. It uses a typical HP 48

application structure—the HOME directory contains a variable that

sets up the application, and the application subdirectory contains two

variables:

s HOME directory:

GEOM Program that sets up the GEOM application.

s DGEOM directory:

SPHERE Main program of the GEOM application.

CST Custom menu for GEOM application.

Each of the numbered headings below shows a main step in the

process of creating the application.

1. Start the Program Development Link.

On your computer, run the PDL program to start the Program

Development Link environment:

=
2. Open a new application (if necessary).

In this example, there’s no current application open, so you don’t

have to open a new one. (If you had an application open, you could

open a new one by getting the “File” menu and picking the “New

Application” command.)

3. Set the installation directory.

You can specify where most variables go on the HP 48.

1. Get the “Options” menu and pick the “Transfer” command. (See
“To Use the Keyboard or the Mouse” earlier.)

2. Next to “HP 48 Installation Directory,” type THOME ZECM T, then

press or pick “OK.”
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4. Create the first variable.

1. Get the “Variable” menu and pick the “New Variable” command.

2. Next to “Variable Name,” type SFHERE. Then press or pick
“Edit in Active.”

5. Enter the HP 48 program.

1. Type the following program lines on the computer. Type the

characters shown. Certain combinations that represent HP /8

characters or commands change automatically when you move to

the next line—for example, <+ changes to %, ~pi changes to m, and

dup changes to [ILIF.

Tab

B ()
Y lq_-__+L 1+'__,.-._.E _:::, Fur lu.l.l':'Lu __:;_ .'. an

zuap (<)
—3 ¢ 'dEpixrt2' —rnum "SURF —rtag
Home

When you finish, your program should look like the one below. If it

doesn’t, use the cursor keys, (Delete), and to fix any mistakes.

DLF

+ ¢ '4eZETEECE' SHUM UWOLY STAG
SHAF
2 ¢ 'dEmErez sHUM USURFY STAG

6. Create other variables as needed.

Use similar steps to create the other variables for the application:

1. Create the variable ©=T. (Use the “Variable” menu, “New
Variable” command.) Then enter the following list:

£ SFHERE « "EXIT" home I I (e=4)
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7.

Create the variable GEOM—but because it needs to go in the

HOME directory, enter its name as £HOME GEOMX—with curly

braces. (Use the “Variable” menu, “New Variable” command.)
Then enter the following program:

£ DGEOM 1 meng >3

Save the application in a file.

All variables in the application are saved in the same file—

GEOM.APP for this example.

1.

2.

Get the “File” menu and pick the “Save As” command.

Next to “File Name,” type GECHM, then press or pick “OK.”

Send the application to the HP 48.

1. If you’re using the computer’s COM2 serial port (instead of

the default COM1 port), get the “Options” menu and pick the

“Communications” command—then under “Serial Port” choose

COM2. (You can also check other communications parameters.)
Then press or pick “OK.”

Make sure the HP 48 and computer are connected. (See

“Connecting the HP 48 and Computer” earlier.)

. On the HP 48, press () to put the calculator in Kermit
Server mode. This means it can be controlled by the computer.

On the computer, get the “Transfer” menu and pick the “Send

All” command. Wait for the “Send All” message to disappear—

the transfer may take half a minute or more. If you get an

error message, the application may have a syntax error, or the

communication parameters may not be set properly. To reset the

HP 48 1/0O parameters, purge variable I0OFAF.

Run the program from the computer.

. Make the HP 48 Immediate window active—you can press (a
shortcut for the “View” menu, “Next Window” command)—or you
can click the mouse anywhere in the “HP 48 Immediate” title bar.
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2. On the computer, type commands to run the program. Each time

you press (e=2), the calculator responds as though you entered the
commands there—and the HP 48 Immediate window shows the

contents of the stack.

GEOM Runs the GEOM setup program and shows
its menu on the calculator.

14 SPHERE Enters a radius and runs the SPHERE
program.

hiore Returns to the HOME directory.

10. Run the program from the HP 48.

On the HP /8, press to end Kermit Server mode. Then press
the following keys:

VAR) GEOM  Runs the GEOM setup program and shows 1its

menu.

2.5 SFHER Enters a radius and runs the SPHERE program.

ESIT Returns to the HOME directory.

11. Exit the Program Development Link.

On the computer, get the “File” menu and pick the “Exit” command.

To Back Up and Restore HP 48 Memory

You can back up and restore HP 48 memory using the “Transfer”

menu. But you can also do this at the MS-DOS prompt—without

using the programming environment:

1. Make sure the HP 48 and computer are connected. (See
“Connecting the HP 48 and Computer” earlier.)

2. If you’re not using the computer’s COM1 serial port, you must run

the Program Development Link software and change the specified
serial port. (See “To Try Out the System” earlier.)

3. On the HP 48, press (¢») to put the calculator in Kermit
Server mode. This means it can be controlled by the computer.

4. On the computer, run the PDL program in one of the following

ways, then follow the instructions on the screen:
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m To back up memory (into a computer file named BAK2.MEM)

pdl b bakz

m To restore memory (from a computer file named BAK2.MEM)

pdl #r bakz

To Get On-Line Information

The main documentation about the Program Development Link

is contained in the on-line Help system, which is available in the

programming environment. To get Help information:

1. Select a topic:

m Program Development Link and HP 48 information. Get

the “Help” menu and choose one of the commands, such as

“Contents” or “HP 48 Command Dictionary.”

m HP 48 command information. Move the cursor to a command

that’s in the window, such as one you’ve just typed, and press

(F1). Or click the right mouse button on a command. (The
“Help” menu, “Context-Sensitive Help” command, also does

this.)

m Menu and dialog box information. If the menu label or menu
command is highlighted, press (F1). If a dialog box is displayed,

press or pick “Help.” (Steps 2 and 3 below don’t apply to

information about a menu operation that’s in progress.)

2. Review the information. You can also copy and paste from the

Help window.

m To make the Help window active, press until its title bar is
highlighted, or click the mouse on the “Help” title bar.

m To move through the current topic, press and
or use (V) and (A) to move the cursor. Or you can click

the mouse pointer on the scroll bar at the right edge of the

display.

m To move ahead to a new topic, move the cursor to any word

(such as a command) or tab to a phrase marked by € » (called a
link), then press (F1). Or click the right mouse button on a word

or marked phrase. (dCortent =p goes to the main Help screen.)
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m To trace your steps back to previous topics, press (Ctr)}-(F1). Or
click the right mouse button on 4+Eack b at the top of the topic.

3. To close the Help window, press or get the “View” menu and
pick “Help Window.”

 

Getting More Information

You can get information from these sources:

m The on-line Help system, which provides the main Program

Development Link information. See “To Get On-Line Information”

above.

m The README.TXT file, which is included and installed on

your hard disk with the Program Development Link. To read

this file, change to your installation directory (such as C:\PDL),

then view it with a text editor or with the MS-DOS command

TYPE README.TXT | MORE.

m The HP 48 Owner’s Manual, which comes with the HP 48.

m The HP 48 Programmer’s Reference Manual.

 

Fixing Problems

If you have problems installing or starting the Program Development

Link, look for the description below that matches your problem. (For

problems that occur while you’re using the Program Development

Link, you’ll get a message—plus an option for getting more

information.)

Installation program doesn’t work properly

m Make sure you’re using Disk 1 for the Program Development Link.

m Make sure you’ve set the current drive to the drive containing

Disk 1. For example, if Disk 1 is in drive A, type a: to make
it the current drive.

m Don’t use / in the directory name. Use \ instead.
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Program Development Link won’t start up

m Make sure you installed the Program Development Link on a hard

disk.

m Make sure you allowed the installation process to finish—and you

restarted the computer afterward.

m Type path and check that your MS-DOS PATH variable
includes the directory where you installed the Program Development

Link, such as C:\PDL. You can edit AUTOEXEC.BAT to add the

directory to PATH. Otherwise, you must change to that drive and

directory to start up the Program Development Link.

m Make sure you’re using MS-DOS version 3.00 or later.

Mouse doesn’t work right

m Make sure the mouse-driver software that came with the mouse or

computer is installed.

m Make sure the mouse driver is activated. For example, your

CONFIG.SYS file might contain DEVICE=C:\MOUSE.SYS—your

AUTOEXEC.BAT file might contain C:\MOUSE.COM.

Cursor doesn’t work right

m If you’re using movement keys on the numeric keypad, make sure

“Num Lock” is off.

m Check your keyboard. Certain shifted-key combinations aren’t

supported on the early HP Vectra PC with only ... across
the top of the keyboard.

 

Limited Warranty

Software: HP warrants for a period of 1 year from the date of

purchase that the software product will execute its programming

instructions when properly installed on the personal computer or

workstation indicated on this package. HP does not warrant that the

operation of the software will be uninterrupted or error free. In the

event that this software product fails to execute its programming

instructions during the warranty period, Customer’s remedy shall

be to return the diskette(s) or tape cartridge(s) (“media”) to HP for
replacement. Should HP be unable to replace the media within a
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reasonable amount of time, Customer’s alternate remedy shall be a

refund of the purchase price upon return of the product and all copies.

Media: HP warrants the media upon which this product is recorded

to be free from defects in materials and workmanship under normal

use for a period of 1 year from the date of purchase. In the event any

media prove to be defective during the warranty period, Customer’s

remedy shall be to return the media to HP for replacement. Should

HP be unable to replace the media within a reasonable amount of

time, Customer’s alternate remedy shall be a refund of the purchase

price upon return of the product and all copies.

Notice of Warranty Claims: Customer must notify HP in writing of

any warranty claim not later than thirty (30) days after the expiration

of the warranty period.

Limitation of Warranty: HP makes no other express warranty,

whether written or oral, with respect to this product. Any implied

warranty of merchantability or fitness is limited to the 1-year duration

of this written warranty. Some states or provinces do not allow

limitations on how long an implied warranty lasts, so the above

limitation or exclusion may not apply to you. (In the UK only: If you

are a “consumer” as defined by statutes, parts of this statement may

not apply to you.)

This warranty gives specific legal rights, and you may also have other

rights which vary from state to state, or province to province.

Exclusive Remedies: The remedies provided above are Customer’s

sole and exclusive remedies. In no event shall HP be hable for

any direct, indirect, special, incidental, or consequential damages

(including lost profit) whether based on warranty, contract, tort, or

any other legal theory. Some states or provinces do not allow the

exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you.

Warranty Service: Warranty service may be obtained from the nearest

HP sales office or other location indicated inside the back cover.
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Program Development Link
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Contacting Hewlett-Packard

For Information about Using the Product. If you have
questions about how to use the Program Development Link,first check
the built-in on-line Help system and “Fixing Problems”in this manual.
(Also check the HP 48 Owner’s Manual, appendix A.) If you can’t find
an answer in those places, you can contact the Calculator Support
department:

Hewlett-Packard

Calculator Support
1000 N.E. Circle Blvd.

Corvallis, OR 97330, U.S.A.

(503) 757-2004
8:00 a.m. to 3:00 p.m. Pacific time

Monday through Friday

For Service. If your product doesn’t seem to work properly, refer to
the built-in on-line Help system for diagnostic instructions. If you are
in the United States and your product requires service, mailit to the
Corvallis Service Center:

Hewlett-Packard

Corvallis Service Center

1030 N.E. Circle Blvd.

Corvallis, OR 97330, U.S.A.

(503) 757-2002

If you are outside the United States, refer to the HP 48 Owner’s
Manual, appendix A, for information on locating the nearest service
center— or write to the address above.

HP Calculator Bulletin Board System. The Bulletin Board
provides for the exchange of software and information between HP
calculator users, developers, and distributors. It operates at
300/1200/2400 baud,full duplex, no parity, 8 bits, 1 stop bit. The
telephone numberis (503) 750-4448. The Bulletin Board is a free
service —you pay for only the long-distance telephone charge.
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